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Thank you for choosing our GCF Controlled Atmosphere Muffle Furnace Series User’s Manual. 
Please read this manual carefully before operating the unit. Keep this manual on -hand so it can be 
used by all operators of the unit. Across International is not responsible for any injury or damage 
caused by misuse. 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

Symbol Explanation of Symbols / Explication des Symboles 

 

Watch out Important note 

 

Protective earth connection 

 

Caution Hot Surface 

 

Caution High Voltage 

 

Danger: Situation is dangerous and may result in death or serious injury 

 

Attention: Beware of rotating objects 

 

Attention: Wear protective gloves and goggles to prevent personal injury 

1. SAFETY NOTES / ILLUSTRATED SYMBOLS 



Ai GCF Controlled Atmosphere Muffle Furnace Series User’s Manual 

4 

 

 

 

English 

 

◆ THIS IS NOT AN EXPLOSION PROOF FURNACE. THIS FURNACE IS NOT SUITABLE FOR USE IN CLASS I, II, OR III 

LOCATIONS, AS DEFINED BY THE NATIONAL ELECTRICAL CODE NFPA 70. 

◆ NEVER LEAVE YOUR FURNACE UNATTENDED WHILE OPERATING. 

◆ Across International is not responsible for any loss of material inside of the unit. 

◆ Never clean the unit with flammable cleaners. Assure that all cleaning agents are completely evaporated and 

dried before reconnecting the unit to the power supply. 

◆ Do not try to heat combustible or explosive materials, or materials that may release corrosive/erosive gases. 

◆ Keep the unit away from any electromagnetic interferences, vibrations, flammable materials, fire, or 

corrosive/erosive gases. 

◆ Avoid vibration or any corrosive/erosive gases around the mantle 

◆ Always wear thermal gloves and protective goggles during operation. 

◆ Always make sure your unit is connected the correct power source (110/220/480V) and grounded properly. 

Always use the power cord that comes with the unit. Never modify the cable or power plug. 

◆  Do not unplug the unit during normal operation. 

◆ Do not position the equipment so that it is difficult to operate the disconnecting device. 

◆ Consider conditions that may affect your furnace’s ability to accurately control its temperatures. Examples 

include extreme heat from radiators, stoves, other mantles, autoclaves, etc. Avoid direct sun, fast-moving air 

currents, and heating/cooling ducts. 

◆ To ensure proper air circulation around the furnace, allow a minimum of 12 inches between the unit and any 

walls or partitions. 

◆ A separate circuit is strongly recommended to prevent possible loss of product due to overloading or failure of 

other equipment on a shared circuit. 

◆ If the equipment is not used in a manner specified in this manual, the protection provided by the equipment 

may be impaired. 

◆ Returning shipment: Save the shipping crate until you are sure your unit is consistently working properly. If for 

any reason you must return the unit, first contact AI for a return material authorization (RMA) number. 

 

 

 

 

 

 

 

 

 

 

 

2. PRECAUTIONS 
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GCF Controlled Atmosphere Muffle Furnaces feature a chamber with alumina fiber insulation or stainless-

steel interior (DISCONTINUED). A double walled steel internal housing helps minimize heat loss to exterior surface. 

Furnace operation is controlled by Eurotherm 3204 digital controller with built-in RS485 digital communications port 

and USB adaptor, allowing the user to connect to a PC for remote control and monitoring of the furnace. You can also 

save or export test results. All our furnaces are CE compliant, UL/CSA (optional).  

 

An atmosphere furnace provides the perfect environment for various procedures in many laboratories, 

providing the controlled temperature and atmosphere specific projects require. The controlled atmosphere is desired 

to complete tasks that require exact temperatures with no room for error. This is the best way to ensure the successful 

outcome of your project because it is sealed tightly to ensure the proper environment. 

 

One of the main components of the atmosphere furnace is the correct mixture of gases. The precise 

measurement of each gas is essential to the success of your project. You can use a separate chamber to mix the gases, 

which are then pumped into the furnace chamber where the work will be completed when they are done mixing. It 

is essential that the separate chamber that holds the gases does not receive any outside air because it could throw 

off the gas mixture and render your project useless. 

 

Features 

◆ Multiple gas inlets and outlets with stainless steel ball valves. Flow meter to control inbound and outbound gas 

flows. Outlets can be ignited to burn off gas. 

◆ Furnace chamber is welded, and oil leak tested to ensure air tightness. Furnace door is sealed with high 

temperature silicon gasket. 

◆ Built-in stainless-steel water-cooling panel protects door sealing gasket when furnace is under heavy use. 

◆ Microprocessor based self-tuning PID control provides optimum thermal process with minimal overshoot. 

◆ Multiple atmosphere processes in a single cycle are possible (ex: binder burn out in air and parts sintering 

under rough vacuum or inert gas environment.) 

◆ Built-in ammeter and dual voltmeters for easy monitoring and troubleshooting. 

◆ Built-in computer interface. 

◆ Overheat protection shuts down the furnace if temperature is outside of acceptable range.  

◆ Power failure protection resumes furnace operation right after the point of failure when power is reestablished 

◆ UL, CSA Certification (Optional) 

3. INTRODUCTION 
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Table 1: Model’s Specification 

 

Model 
Max 
Temp 
(ºC) 

Chamber 
Size. 

(LxWxH) 
(inches) 

Voltage 
(V) 

Current 
(A) 

Frequenc
y (Hz) / 
Phase 
(Ph) 

Power 
(kW) 

Maximum/ 
Constant 
working 

temp. 
(ºC) 

Max. 
Positive 
Pressure 

(PSI) 

Thermo-
couple 

Heating 
Elements 
Type/QTY 

Built in 
Circuit 

Breaker 
(A) 

Shipping 
Dimension

s 
(LxWxH) 
(inches) 

Unit / 
Shipping 
Weight 
(lbs.) 

GCF1100B 1100 11x9x9 220 23 
50/60  
single 

5 1100/1000 3 K Kanthal 32 40x30x40 300/400 

GCF1200 1200 

12x8x8 

220 

19 

50/60  
single 

4.2 

1200/1100 3 K Kanthal 

25 38x26x44 350/420 

16x12x12 42 9.24 60 40x30x48 400/470 

20x16x16 72 15.84 100 49x44x61 800/950 

40x24x24 480 60A 55 80 75x50x71 67x44x65 

GCF1400 1400 

6x6x6 

220 

14 
50/60 
single 

3 

1400/1300 3 S 

(SiC) / 4 20 28x33x45 290/400 

12x8x8 45 9.9 (SiC) / 8 40 33x34x50 450/580 

16x12x12 53 11.6 (SiC) / 12 80 43x35x55 590/720 

GCF1700 1700 

6x6x6 

220 

17  
50/60 
single 

3.7 

1700/1600 3 B 

MoSi2 /4 20 33x30x51 430/510 

12x8x8 45 9.9 MoSi2 /8 40 37x26x50 620/720 

16x12x12 80 17.6 MoSi2 /12 80 34x29x60 880/1050 

GCF1750 1750 16.12.12 220 60A 50/60 
single 

13  1750/1650 3 B 
MoSi2 /12 

80 
37x42x70 915/1131 

GCF1750 1750 20X16X16 480 37A 50/60 3-
phase 

31.5 1750/1650 3 B 
MoSi2/18 

50 
43 x 46  81 1179/1830 

 

 
Table 2: Below table applies to all models 

 
Minimum Temperature 300 ºC 

Temperature Controller Eurotherm 3204 

Temperature Controller Precision ±1 

Heating Rate 5-15 ºC 

Gas Inlet/Outlet 1/4" hose barb with 1/4" BSPT (British Standard Pipe Thread) 

Compliance CE, UL/CSA (optional) 

 

 

 
Table 3: Maximum Working Temperature  
 

 Maximum Working Temperature (ºC) 

Working Environment GCF1200/GCF1100B GCF1400 GCF1700/GCF1750 

Air  1200/1100 1400 1700 

Helium (He), Neon (Ne), Argon (Ar) 1200/1100 1400 1650 

Nitrogen (N2) 1200/1100 1270 1500 

Hydrocarbon gas 1200/1100 1250 1550 

Hydrogen (H2) up to 5% 1200/1100 1200 1500 

 

 

 

 

 

 
 

 

 

 

 

4. SPECIFICATIONS 
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Gas Outlet 

Vaccum Port 

Vacuum Gauge 

Door Handle 

Stainless-Steel 
door with water 
cooling channel 
and sealing gasket 

Gas Outlet 

Dual-wall housing 

Water Inlet 

Door sealing screw 

Door hinge 
with safety 
switch 

Water Outlet 

Volt-meter  

Amp-meter 

Eurotherm  
temperature 
Controller 

On Main 
Power 
switch 

Power 
Indicator 

Open 
Circuit  

Off 

5. COMPONENTS 
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Thermocouple 

Gas Inlet 

Circuit Breaker

 

Thermocouple 

Heavy duty wheels  

Computer Interface 
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Depending on what unit you bought, it is necessary for 2-3 people to assist in uncrating this unit. Crate can 

weigh between 400-1050 Lbs. and can be a little heavy for one person. Remember your safety is our 

concern so please use all the safety equipment to move the crate such as a pallet jack and good gloves. 

When uncrating the unit, remove the bottom screws of crate and pull the crate up, remembering that 2-3 

people will need to help. Next remove all foam and any plastic bags that come with unit. 

 

Unit must be installed 2 feet away from the wall for easy access of main power switch. 

 

Unit must be installed on a horizontal and shock-proof platform away from any explosive gases and 

materials. 

 

Remove the stuffing material from GCF1400, GCF1700, and GCF1750 models ONLY. 

1. Unscrew and open the top panel (picture1). 

2. Remove the stuffing material (picture2). 

3. Put the top panel back and secure it (picture2). 

 

 

Picture 1        Picture 2         Picture 3- 

 

 

 

 

 

 

 

 

 

 

 

 

6. INSTALLATION 
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6.1 Wiring Installation 

6.1.1 Our furnaces come with a built-in circuit breaker. The brown and blue wires in picture should be the line 

inputs, while the black wire is ground.  

6.1.2 The red wire in the thermocouple should be connected to the positive pole and the green wire to the 

negative pole.  

 

6.2 Thermocouple  

6.2.1 Insert thermocouple through the provided thermocouple nut (picture). 

6.2.2 Thread the rubber sealing o-ring over the thermocouple and secure it to the nut (picture). 

6.2.3 Insert the assembled thermocouple into the thermocouple hole in the back of the furnace (picture). 

6.2.4 Tighten the nut (picture). 

 

 

To test if you connected the wires correctly, turn the main power switch on and notice if the temperature 

controller powers on. If not, re-check your connection. 
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6.3 Gas Filling  

6.3.1 Check Furnace air tightness 

6.3.1.1 Close furnace door, tighten all door screws and close all valves except one gas inlet 

6.3.1.2 Fill the furnace with gas thru the gas inlet until pressure gauge reads 0.03MPa. 

6.3.1.3 Hold this pressure for two hours and check if pressure gauge reading changes. 

6.3.1.4 If pressure gauge reading drops, check and make sure all door screws are tightened properly 

and sealing gasket is clean and intact. 

 
6.3.2 Outgas air in the chamber with inert gas 

6.3.2.1 Inert gas should be filled into furnace before heating up 

6.3.2.2 Inert gases can be filled into the furnace thru three gas inbound valves. Gas exhausting valves 

should be wide open during this operation to allow air to go out of the furnace quickly. 

6.3.2.3 Generally, oxygen density will drop to 100ppm, if ten times of the volume of the furnace 

chamber inert gas is filled. 

6.3.2.4 When oxygen density inside the furnace has reached the required level, close the gas 

exhausting valve to save inert gas. 

6.3.2.5 During the furnace operation, a positive pressure must be maintained in the furnace chamber, 

to prevent air going into the furnace and allow gas to flow out. However, the positive pressure 

must be less than 3 PSI over 1ATM (pressure gauge reading 0 means 1 ATM). 

 

6.3.3 Pre-vacuuming the furnace 

6.3.3.1 Connect the pipe of the vacuum pump to any of the gas exhausting valves 

6.3.3.2 Pre-vacuum the furnace chamber (to around -10 PSI) 

6.3.3.3 Fill inert gas 

6.3.3.4 Vacuum the furnace chamber again (to around -10 PSI) 

6.3.3.5 Repeat this a few times until gas condition reach required level 

6.3.3.6 However, the positive pressure must be less than 3 PSI over 1ATM (pressure gauge reading 0 

means 1 ATM). 

 

6.3.4 How to flow protection gas properly  

 

After vacuum the chamber and fill in protection gas, try to keep chamber pressure slightly higher than ambient 
pressure. Gas should be filled from the inlet in the back and flow out from the valve on the top, to create a 
smooth gas flow. Try to keep chamber pressure within 0 to 0.04MPa, and do not let gas fill into the chamber 
too much that may create a dangerous high pressure. Try NOT to keep gas inside the furnace all the time but 
let gas flow in and out smoothly. 
 
For reference only: to keep monitoring a smooth gas flow, open the gas outlet all the way and connect it to a 
hose and then place the hose into a bucket with water (the bucket should be placed outdoor if you use 
dangerous or poison gas). Use the flow meter to adjust flow speed and make sure you see bubble coming out 
from the hose (otherwise water or air may back flow into the furnace) in the bucket. Bubble speed will give 
you an idea how well gas flows and also keep the furnace chamber not in high pressure.  
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6.3.5 Make sure gas is flowing properly before turning on the furnace 

 

6.3.6 DO NOT turn off gas flow until your furnace is cooled down, otherwise air may flow into the chamber 

causing oxidization even explosion.  

 
 

CAUTION! Across International DOES NOT recommend the use of hydrogen or other dangerous gas, and 
we are not responsible for any damage or consequence damage caused by that. 

 
 

FOR REFERENCE ONLY 
 

Hydrogen of 4% to 75% purity may cause explosion with air when heated. If you need to fill hydrogen, you 
need to have some fail-save device built in. Outgassing process is very important, and you also need to check the 
purity of hydrogen filled. 
 

To test hydrogen purity, use a small test tube upside down and collect some hydrogen from the chamber, then 
cover it with your thumb. Move the test tube to an open flame and remove your thumb. If you hear a sharp explosion, 
the hydrogen is not pure. If you hear a slight explosion the hydrogen is pure. You can turn on the furnace if hydrogen 
is pure; otherwise you need to outgas the chamber a few more times. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

7. OPERATION 
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7.1 Running the furnace 

 

7.1.1 After connecting the power wires as in section 6.1, flip on the circuit breaker  

7.1.2 Turn the main power switch on, the temperature controller display should turn on. 

7.1.3 Place the alumina cushion block in the bottom of the chamber.  

 

7.1.4 Place the sample material in the center of the furnace chamber 

7.1.5 Place the door thermal block using the stainless-steel tongs (see picture) 

 

7.1.6 Close the door and tighten all the screws. 

7.1.7 Set the temperature controller (refer to section 

7.1.8 Check the air tightness of the furnace (see section 6.3 Gas Filling) 

7.1.9 Press “On” button, you should hear the AC contactor making a click sound.  

7.1.10 Press and hold the “RUN/RST” for three seconds on the controller to start the controller program.    

 

 

GCF 1700, and 1750 ONLY: if the amp-meter reads over 200A for longer than one minute after “RUN/RST” 
is pressed and hold for three seconds, shut down the furnace immediate to avoid damage to the 
transformer and the heating element. This only happens in a short period of time after the furnace is 
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started (within 250°C). 
 

Solutions:   
▪ Set a value (prompt 306) to a lower number for the amp restriction trigger.  
▪ Turn down the O-H value of PID used in this temperature range after turn-off (see Picture 44) 
▪ Select No.1 PID for such temperature range as its O-H value has been set before delivery from 

the factory. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
For detailed instructions of temperature controller operations, please refer to the instruction of the Eurotherm 3204 temperature controller, 
the instructions here is only used to explain those commonly used or difficult operations for convenient use by the users. 
 

8.1 Controller Program Setting:  

There are five programs, and each program consists of 8 steps or segments.  Three parameters are required for each sequence of program 
in setting: 

• Heating rate  

• End temperature  

8. ADVANCED SETTING 
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• Enable or disable dwell function  
 
A Program is an eight-segment programmer consisting of four ramp/dwell pairs. Each ramp consists of a controlled rate of change of 
setpoint to a target level. Each ramp is followed by a dwell at that level. The ramp rate, target level and dwell time can also be set by the 
user 

 
The controller can put in Auto, manual or off mode. For the muffle furnace, we will only use “Auto” mode.  

• Auto mode is the normal operation where the output is adjusted automatically by the controller in response to changes in the measured 
temperature. In Auto mode all the alarms and the special functions (auto tuning, soft start, timer and programmer) are operative 

• Manual mode means that the controller output power is manually set by the operator. The input sensor is still connected and reading the 
temperature, but the control loop is ‘open’. 

• Off mode means that the heating and cooling outputs are turned off. The process alarm and analogue retransmission outputs will, however, still 
be active while Band and deviation alarm will be OFF. 
 

To select Auto, Manual or Off Mode” 
1. Press and hold  and arrows together for more than 1 second on the home display.  
2. “Auto” is shown in the upper display. After 5 seconds, the lower display will scroll the longer description of this parameter “LOOP MODE – AUTO 

MANUAL OFF”. 
3. Press to select “Auto”.  
4. When the desired mode is selected, do not push any other button. After 2 seconds the controller will return to the home display.  

 
To Operate the Program  
 

Operation Action Indication 

To run a program  Press and quickly release  
Beacon -- RUN = On 
Scrolling display - TIMER RUNNING 

To hold a program  Press and quickly release  
Beacon -- RUN = Flashing 
Scrolling display - TIMER HOLD 

To reset a program  Press and hold for more than one second  
Beacon -- RUN = Off 
If End Type = Off then OFF will be displayed at the end of the program 

 Program ended 
Beacon -- RUN = Off SPX = On if End Type = SP2 
Scrolling display - TIMER END 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

8.2 Temperature profile program 

Below are the procedures for setting the following curve program. Below graph is for 1700C unit. 
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Parameter Action Indication Notes 

WRK.OP Press   to select “WRK.OP” 

 

Working Output – is the output from the controller expressed as a percentage 
of full output. It appears when the controller is in Auto mode 

PROG Press   to select “PROG” 

 

Program – the controller can save up to 5 programs.  
 
In this example, we will use program 1  

RAMP.U 
Press   to select “RAMP.U” 
 

Press  or to adjust  

Setpoint ramp units - to set the units of the ramp rate 
min – minutes, Hour- Hours, SEC- seconds 
 
In this example, we will use minutes as ramp rate units.  

DWEL.U 
Press   to select “DWEL.U” 
 

Press  or to adjust  

Set dwell duration -  to set the units of the dwell time 
Min -  0:00 to 99:59 mm:ss, Hour -  0:00 to 99:59 hh:mm 
 
In this example, we will use minutes as dwell time units. 

RMP.1 
Press   to select “RMP.1” 
 

Press  or to adjust 
 

First ramp rate - OFF, 0:01 to 3000 units per min or hour as set by “RAMP.U” 
 
In this example the setpoint will ramp to 300C at 10.0 units per minute  

T.SP1 
Press   to select “T.SP1” 
 

Press  or to adjust 
 

Target set point 1- to set the target value for the first setpoint 
 
In this example the setpoint will ramp from room temperature to the first target  
 

RMP1.E 
Press   to select “RMP1.E” 
 

Press  or to adjust 
 

Ramp event 1 – to enable to disable the ramp rate set by “RMP.1” 
 
In this example the ramp event 1 will be set to “ON” 

DWEL.1 
Press   to select “DWEL.1” 
 

Press  or to adjust 
 

First dwell - to set the period of the first dwell. 
OFF, 0:01 to 99:59 hh:mm or mm:ss as set by “DWEL.U” 
For dwell periods greater than 1 hour, the ‘Resolution’ value above must be set 
in Hours. If it is set in minutes, it cannot display more than 60 minutes. 
 
In this example the setpoint will not dwell at “TSP.1”  

Resolution set in Hour 
1 hour = 1:00 
10 hours = 10:00 
1 min = 0:01 
1 sec = OFF 

Resolution set in min 
1 hour = 60:00 
10 hours = cannot be set 
1 min = 1:00 
1 sec = 0:01 
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DWL1.E 
Press   to select “DWL1.E” 
 

Press  or to adjust 
 

Dwell event 1 – to enable to disable the dwell set by “DWEL.1” 
 
In this example the ramp event will be set to “OFF” as we are not dwelling at the 
first set point 

RMP.2 
Press   to select “RMP.2” 
 

Press  or to adjust 
 

In this example the setpoint will ramp from 300C to 900C at 10.0 units per 
minute  

T.SP2 
Press   to select “T.SP2” 
 

Press  or to adjust 
 

 
In this example the setpoint will ramp from 300C to 900C  
 

RAMP2.E 
Press   to select “RAMP2.E” 
 

Press  or to adjust 
 

In this example the ramp event 2 will be set to “ON” 

DWEL.2 
Press   to select “DWEL.2” 
 

Press  or to adjust  

In this example the dwell time will be set to “20:00” as we are dwelling at 
“T.SP2” 900C for 20 minutes 
 

DWL2.E 
Press   to select “DWL2.E” 
 

Press  or to adjust 
 

In this example the dwell event 2 will be set to “ON”  

RMP.3 
Press   to select “RMP.3” 
 

Press  or to adjust 
 

In this example the setpoint will ramp from 900C to 1600C at 5.0 units per 
minute  

T.SP3 
Press   to select “T.SP3” 
 

Press  or to adjust 
 

 
In this example the setpoint will ramp from 900C to 1600C 
 

RMP3.E 
Press   to select “RMP3.E” 
 

Press  or to adjust 
 

In this example the ramp event 3 will be set to “ON” 

DWEL.3 
Press   to select “DWEL.3” 
 

Press  or to adjust 
 

In this example the dwell time will be set to “30:00” as we are dwelling at 
“T.SP3” 1600C for 30 minutes 

DWL3.E 
Press   to select “DWL3.E” 
 

Press  or to adjust 
 

In this example the dwell event 3 will be set to “ON” 

RMP.4 
Press   to select “RMP.4” 
 

Press  or to adjust 
 

In this example the setpoint will ramp from 1600C to 1200C at 5.0 units per 
minute  

T.SP4 
Press   to select “T.SP4” 
 

Press  or to adjust 
 

 
In this example the setpoint will ramp from 1600C to 1200C 
 

RAMP4.E 
Press   to select “RAMP4.E” 
 

Press  or to adjust 
 

In this example the ramp event 4 will be set to “ON” 
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DWEL.4 
Press   to select “DWEL.4” 
 

Press  or to adjust 
 

In this example the dwell time will be set to “OFF” as we are not dwelling at 
“T.SP4” 1200C 

DWL4.E 
Press   to select “DWL4.E” 
 

Press  or to adjust 
 

In this example the dwell event 4 will be set to “OFF” 

RMP.5 
Press   to select “RMP.5” 
 

Press  or to adjust 
 

In this example the setpoint will ramp from 1200C to 20C at 10.0 units per 
minute  

T.SP5 
Press   to select “T.SP5” 
 

Press  or to adjust 
 

 
In this example the setpoint will ramp from 1200C to 20 
 

RMP5.E 
Press   to select “RMP5.E” 
 

Press  or to adjust 
 

In this example the ramp event 5 will be set to “ON” 

DWEL.5 
Press   to select “DWEL.5” 
 

Press  or to adjust 
 

In this example the dwell time will be set to “OFF” as we are not dwelling at 
“T.SP5” 20C 

DWL5.E 
Press   to select “DWL5.E” 
 

Press  or to adjust 
 

In this example the dwell event 5 will be set to “OFF” 

 

 

 

Caution: 

(Important! Only for furnaces with max. temp of 1600°C and up) If the amp reading is over 200A for longer than 

one minute after RUN is pressed for three seconds, shut down the furnace immediately to avoid damage to the 

transformer and heating elements. This only happens in a short time period after the furnace is started (within 

250°C). 
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Problem 

 

Reason 

 

 

Solution 

Turn off light is not on after release the 
power lock 

FU1 fuse out 
Replace fuse after making sure 
there is no short circuit. 

Circuit Open light is on FU2 fuse out 
Replace fuse after making sure 
there is no short circuit. 

PV temperature display decreasing instead 
of increasing when furnace is heating up 

Positive and negative are 
reversed. 

Reverse the positive and negative 
wires. 

Ammeter has not reading but voltmeter has 
voltage reading 

Heating elements broken Change heating elements. 

All power is normal but the furnace is not 
working. 

Parameter setting error. Change parameters. 

All meters and power are normal, but 
temperature is not rising. 

Wiring problem. Call Ai Service Department 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. TROUBLESHOOTING 
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10.1 Maintenance and cautions of the furnace 

 

Please take the time to review all aspects of the unit and possible wear and tear items that are not listed below. 

10.1.1 It is incumbent for you as a customer to have someone competent to maintain and service your 
equipment in a safe manner. No certification or special licenses are needed to maintain this unit, 
however, due to ever increasing of Safety regulations and OSHA, some level or Risk Management is 
needed for you to safely maintain this unit.  

10.1.2 Power Cord and Plug – Do not modify or change the power cord or plug. A dedicated circuit should be 
established power output  

10.1.3 The furnace should be baked when it is operated for the first time or after a long time. 
10.1.4 Baking time: ambient temperature to 200℃ in two hours, 200℃ to 600℃ in four hour and hold for two 

hours.  Bake the furnace before conducting any sintering experiment to prevent the furnace cavity from 
cracking. 

10.1.5 Clean the furnace frequently; check at regular interval to see if the furnace wires are in good connection. 
10.1.6 The furnace temperature should not exceed the rated temperature during the operation to prevent any 

damage on the heating element; no flammable fluid and melted metal should be put into the furnace. 
10.1.7 The temperature is generally controlled under 300℃ in the operation, and the temperature should not 

be raised at a faster speed as the furnace cavity is cold and needs to absorb a large number of heats in 
the beginning. 

10.1.8 Try to take down the temperature as slow as possible (lower than 10℃/Min) to protect the insulation of 
the furnace chamber. 
 

10.2 Maintenance and cautions of MoSi2 heating elements 

10.2.1 Be very careful to install and uninstall the MoSi2 heating element as it is hard and brittle. 
10.2.2 The MoSi2 heating element should be stored in dry place to prevent its aluminized ends being 

moisturized and deteriorating. 
10.2.3 The connection of the MoSi2 heating element should be closely attached to the white aluminum head 

of the cold end of the heating element. 
10.2.4 The MoSi2 furnace should not be operated under a constant temperature of 400-700℃ as it tends to 

react with the oxygen and vapor in the air and become pulverized under such constant temperature. 
10.2.5 The current should be limited for MoSi2 element when operated under 250℃, as the resistance of the 

MoSi2, which increases with the temperature, is very low at low temperature and the current through 
it becomes very high. 

10.2.6 The resistance of MoSi2 won’t increase with the frequent use of heating element, thus the new and used 
MoSi2 heating elements can be used together. 

10.2.7 The connection of the MoSi2 heating element should be closely attached to the white aluminum head 
of the cold end of the heating element to prevent fire striking. 

10.2.8 Testing the unit to see if all the repairs have worked is the form of verification. 
 
 
 

 

 

10.  MAINTENANCE AND INSPECTION 
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10.3 Maintenance and cautions of SiC heating element: 

10.3.1 The furnace temperature should not exceed the rated temperature for a long time during the 

operation to prevent any damage on the heating element; no flammable fluid and melted metal 

should be put into the furnace. 

10.3.2 Be very careful to install and uninstall the SiC heating element as it is hard and brittle. 

10.3.3 The SiC heating element should be stored in dry place to prevent its aluminized ends being 

moisturized and deteriorating. 

10.3.4 The melted KOH, NaOH, Na2CO3 and K2CO3 will decompose SiC at red heat temperature, and alkaline, 

alkaline earth metals, sulphate and boride etc. may erode SiC, thus they should not be exposed to SiC. 

10.3.5 The connection of the SiC heating element should be closely attached to the white aluminum head of 

the cold end of the heating element to prevent fire striking. 

10.3.6 SiC reacts with Cl2 at 600℃ and with vapor at 1300-1400℃, it cannot be oxidized under 1000℃, but 

significantly 

10.3.7 oxidized at 1350℃, a protective film of SiO2 is generated on the surface of the SiC at 1350-1500℃ to 

prevent SiC being further oxidized  

10.3.8 The resistance of SiC will increase with the operation time k of the heating element; the reactions ar as 

follow, 

SiC + 2O2  =  SiO2 + CO2 

SiC + 4H2O =  SiO2 + 4H2 + CO2 

The more SiO2 it contains, the more resistance it has, thus the new SiC heating element should not be 

used with the used heating element to prevent the unbalance of resistance which has very adverse 

effect on the temperature field and the SiC heating element. 

 
 
10.4  Inspection  

10.4.1 Every 3 – 6 months, qualified personnel should inspect the unit and keep any records of it 

maintenance for any City, State, or Federal Inspector. 

10.4.2 Service Technician - equipment being serviced should at least be shut down for 4 hours prior to the 

Service Technician arriving.  

10.4.3 Product specific risks that may affect service personnel: 

10.4.4 Glass being broken - Use caution and proper gloves to handle broken glass. 

10.4.5 Using Antistatic Gloves and or Grounding yourself is important so you won’t get shocked. 

10.4.6 Verification of the safe sate of the equipment after repair: 

10.4.6.1 Visual inspections of the unit, is the first thing that will need to be done. Make sure that 

everything is adjusted or cleaned.  

10.4.6.2 Testing the unit to see if all the repairs have worked is the form of verification. 
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11.1 MoSi2 Heating Element 
11.1.1 MoSi2 heating element is made by powder metallurgic method through squeezing and sintering. If Si and Mo are 

evenly blended and granularity normally distributed the heating element will have little temperature difference in 
different areas when heated, which is favorable to form an even temperature field. The cold end and hot end of the 
MoSi2 heating element are connected by projection welding. 

11.1.2 The melting point of MoSi2 is 2030℃, and there are two maximum operation temperatures as 1700℃ and 1800℃ for 
MoSi2 heating element. 

11.1.3 A protective glass film is generated on the surface of the MoSi2 heating element when heated, which is of great 
oxidation resistance and can be generated again to prevent further oxidation when damaged during the operation. 

11.1.4 Reductive gas may destroy the protective film of MoSi2; nevertheless, the MoSi2 heating element can be operated 
under the circumstance of reductive gas at a temperature below 1350℃. The vapor of chlorine and sulphur are greatly 
corrosive to the MoSi2 heating element. 

11.1.5 Maximum temperature inside the chamber is related to the gas environment. If temperature in the chamber is higher 
than specified, heating elements will react with the gas and could be damaged. (Refer to table below). 

 

Gas Maximum heating element temperature 
GCF1600 GCF1700 

Air, Oxygen (O2), Nitrogen Dioxide (NO2), Carbon Dioxide (CO2) 1600°C 1700°C 
Helium (He), Neon (Ne), Argon (Ar) 1550°C 1650°C 
Sulfur Dioxide (SO2) 1500°C 1600°C 
Nitrogen (N2), Carbon Monoxide (CO) 1400°C 1500°C 
Wet Hydrogen (H2) 1300°C 1400°C 
Dry Hydrogen (H2) 1250°C 1350°C 

 

11.2 SiC Heating Element 
 

11.2.1 SiC heating element is a high temperature nonmetallic heating element that is made from pure hexagonal 
carborundum through blank making, high temperature siliconization and recrystallization at 2200℃. The temperature 
on the surface may reach 1450℃, and the heating element will be aged rapidly and easily burnt out when the 
temperature exceeds 1500℃. The SiC heating element can work for more than 2,000 consecutive hours under proper 
operation conditions, besides the difference of internal quality, its durability is related to the surface loading (the 
larger surface loading, the shorter durability), the ambiance, heating means (interrupted or non-interrupted) and the 
connection way (in series or in parallel) of the heating elements in use. 

11.2.2 SiC is hard and brittle with a small expansion coefficient and durable against instant cooling, heating up and 
deformation, and it is chemically stable with great acid resistance and does not react with strong acid. 

11.2.3 The resistance of SiC changes with the temperature of the element as SiC is a non-linear resistor. The resistance 
descends when the temperature rises from ambient temperature to about 900℃, while ascends when the 
temperature rises from about 900℃, that is, the SiC heating element has minimum resistance at about 900℃, and the 
resistance of SiC heating element is generally referred to the resistance at this temperature. 

11.2.4 Maximum temperature inside the chamber is related to the gas environment. If temperature in the chamber is higher 
than specified, heating elements will react with the gas and could be damaged. (Refer to table below). 

 

Gas Maximum heating element temperature 
Air 1400°C 
Helium (He), Neon (Ne), Argon (Ar) 1400°C 
Nitrogen (N2) 1270°C 
Hydrocarbon gas 1150°C 
Rough vacuum 1100°C 
Hydrogen (H2) 1100°C 

11. HEATING ELEMENT INTRODUCTION  
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11.3 Replacing the Heating Element 
 

If heating element is damage, please follow the instruction below for replacement. 
 

          
Step 1                                Step 2                               Step 3 

 

                  
Step 4                        Step 5                      Step 6                      Step 7 

 
Step 1. Open the furnace cover 
Step 2. Take off screws of clip for heating element 
Step 3. Release the aluminum clip 
Step 4. Take off screws of metal clip that tighten the ceramic block 
Step 5. Take out the ceramic block between rods of U-shape heating element. 
Step 6. Take out the heating element 
Step 7. Replace with a new heating element. Put the ceramic block together with the heating element, and make 
sure it is in the same position. 
Step 8. Follow the reserve steps to install heating element back. 
 
Cautions: 

1. Keep the heat end of the heating element about 15mm from the bottom of the furnace cavity a space of 
15mm when inserting the heating element. 

2. When clamping the heating element with aluminum strip and tight clips, be sure not so tight that the MoSi2 
is broken or too loose that the contact is poor and cause high resistance and electric arc. 

3. MoSi2 heating elements have low resistance and are generally connected in series. 
4. Be very careful in installation of heating elements as they are very brittle and fragile. 
5. Use pyrocotton to cover the gap between the heating element and furnace cavity which is caused by the 

over-high temperature on top of the furnace. 
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iTools is a configuration and monitoring package which will edit, store and ‘clone’ complete controller configurations. 
iTools can be used to configure all the functions of 3200 series controllers described in this manual.  
 
12.1 Starting iTools  

1. Download iTools from the USB supplied with the unit 

2. Connect the furnace to the computer using the RS-485 to RS-232 to USB adapter. 

3. Open iTools and select on “Scan” -> “Ok”  

 

4. Once the controller is found, you will see it on the bottom panel  

 

12. SOFTWARE SETUP 
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5. The browser on the left shows the List Headers. To display parameters within a list double click the Header 

or select “Parameter Explorer”. Click on a list header to display parameters associated with this list.  

 
6. The instrument view may be turned on off using the ‘View’ menu and selecting ‘Panel Views’. 

You can access the current program/ heating profile by selecting “Programmer” in the left panel.  

You can run the controller from the software by pressing the up and down arrow under device panel.  
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12.2 Data Recording  
1. Once you have the controller configured, a 20-character product key will need to be entered to be able to 

record data continuously through the process. Under “Options” -> “Advanced” -> iTools Control Panel and type 
in the following product key “D7047-10F10-607C0-0C855” -> “Ok”   

 

2. Click on “OPC Scope”  

3. To plot set value and present value follow the steps as in picture below 
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4. To display the present value and the set point in a chart format, under OPC Scope click on “Chart” and select 

the two items as below  

 
5. You can change the logging rate by click on “Options” under OPC Scope -> “Data Logger Options”. Under “File 

Write Mode” select “Append to Existing File” -> “Ok”  

 
6. To enable data recording, click on start data logging icon and select the path for the excel file -> “Save”. 

Then, data logging icon will turn yellow indicating that the data logging has started 
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7. To exit out of configuration mode -> click on “Access” and the communication will stop 
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Across International (AI) warrants for the original user of this product in the U.S.A. only that this product will be free 
from defects in material and workmanship for a period of one year from the date of delivery to the original user – the 
“Warranty Period”. 
 
During the warranty period, AI, at its election and expense, will repair or replace the product or parts that are proven 
to manufacturer’s satisfaction to be defective, or at manufacturer’s option, refund the price or credit (against the 
price of future purchases of the product) the price of any products that are proven to manufacturer’s satisfaction to 
be defective. 
 
This warranty does not include any labor charges if outside of the U.S.A. This warranty does not cover any damage 
due to accident, misuse, negligence, or abnormal use. This warranty is void in the event that repairs are made by 
anyone other than AI without prior authorization from AI. 
 
Use of AI’s product in a system that includes components not manufactured by AI is not covered by this warranty. Any 
alteration or removal of the serial number on AI’s products will void this warranty. Under no circumstances will AI be 
liable for indirect, incidental, consequential, or special damages. 
 
The terms of this warranty are governed by the laws of the states of New Jersey and Nevada without regards to the 
principles of conflicts of laws thereof. If any provision of this limited warranty is held to be unenforceable by any court 
of competent jurisdiction, the remainder of this limited warranty will remain in full force and effect. 
 
This warranty is in lieu of and excludes all other warranties or obligations, either express or implied. AI expressly 
disclaims all implied warranties, including without limitation, the warranties of merchantability and fitness for a 
particular purpose. 
 

After the warranty period, AI will continue to provide support and spare parts at a reasonable cost. 
Returning shipment: Save the shipping crate until you are sure your unit is consistently working properly. If for 
any reason you must return the unit, first contact AI for a return material authorization (RMA) number. 
 

 

Ai NEW JERSEY  AI NEVADA 

Main Office: 111 DORSA AVE, LIVINGSTON, NJ 07039 

Shipping: 119 DORSA AVE, LIVINGSTON, NJ 07039 

Phone:  888-988-0899 

Service Dept:       support@acrossinternational.com  

 Main Office: 600 Islands Dr., SPARKS, NV 89431 

Shipping: 600 Islands Dr., SPARKS, NV 89431 

Phone:               888-988-0899 

Service Dept:    support@acrossinternational.com  

13. WARRANTY 
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